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Please Read This First!!
BassetPro is delivered with a blank
database.  If you are using this program
for evaluation purposes, please see
Appendix B to install the sample
database.



Introduction

Thank you for choosing a SageData Solutions.  By using
BassetPro , we know that you will save time, money, and
reduce administration overhead.  Our programs are developed
with the end users in mind, which can start using the system
immediately, taking full advantage of its benefits.  Our systems
are intuitive and designed for a specific niche application.  You
receive a custom-tailored package, for the price of an “off-the-
shelf” application.

The original BASSET program is in use by many different
organizations all over the world.  To develop BassetPro, we took
the best traits from BASSET and incorporated features
requested by users, resellers and potential users.  BassetPro is
Year 2000 compliant and network ready.

This manual should answer most of your questions about how
to set up and operate the hardware and software for your
BassetPro system. If it doesn’t, please don’t hesitate to contact
me as indicated below.

We always welcome feedback, comments and suggestions from
our customers.  Fax them to me at (613) 225-8664, send an e-
mail to nt@sage.ca or you can call me at (613) 225-4404.

Nancy Tervo
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BassetPro - Start to Finish

Install BassetPro on your PC, by choosing “RUN” and entering a:setup.  Double
click on your BassetPro icon.  You are brought to the Main Menu of BassetPro.

Next, under the Setup menu, enter your  Supplier, Owner, Manufacturer,
Class and Model  fields.

Still within your Setup menu, cursor to Asset and enter all the pertinent
information for your assets. (You can skip this step if you import your existing
data or plan to capture your data on the handheld).

Insert your BassetPro program disk (128K SSD) into the bottom slot (B) of
the Workabout and your data disk into the top slot. Close the Disk/Battery
drawer.

Start BassetPro by pressing the PSION+CTRL+DEL  keys simultaneously.
BassetPro will load automatically.

Ensure that the Workabout screen is displaying the current date and time.  If
not, cursor to Help – Set Date/Time  and make the necessary changes.

Cursor to Scanner Type  and select T for Tethered (2-piece system) or I for
Integrated  (1-piece system). NOTE:  the integrated Wand is treated as a
tethered scanner.

In the Action Menu, use the arrow keys to go to Audit , scan in your Location
bar code and then your Asset bar codes, entering the information requested.

Under the File  Menu, select Communication Mode  so that the Workabout
is in Ready mode.  Connect your Workabout to your PC either with a cable or
put it in the docking station.

On the desktop, select File – Transfer – Upload from Handheld .

Always ensure your time is correct on the Workabout as the system
uses this date automatically and it is crucial to the accuracy and integrity
of your data!





Part 1

BassetPro on the P.C.





Chapter 1
Overview:  the Setup Menu

In this chapter we will cover the Setup Menu and how you can
use it to maximize BassetPro’s potential on your PC.

In this menu you can setup:

· Assets ·Manufacturers
· Locations ·Models
· Suppliers ·Short Codes
· Owners ·Class

In the Setup Menu you can also choose the settings for:
· What type of Handheld you are using
· Which communications port you are using on your PC
· The path on your network where your BassetPro data is

 stored
· Your printer settings
· Changing the names of your fields and labels to better

reflect your organization.
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Chapter 1
SETUP MENU

The SETUP Menu is where you lay the groundwork for your asset infor-
mation database.

You can opt to retain the default field names. If this is the case, continue
with your set-up starting with Location (only if you are using only the PC
program, as typically you would set-up the Locations using the handheld).

  

If you wish to customize the field names to suit your working environment,
cursor down to “Label Global” . You only have to change these field
labels once and the change is reflected in the whole system, including the
Handheld.

 The screen display below illustrates how you can use two languages and
you can “Set” the labels for the original ones or Option 1 or 2.  Note that
whatever you choose, these titles will be downloaded to the handheld.
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Setup Menu – Fields
Highlight the screen you wish to customize and click on Select .   Only the
first three choices are currently activated – Menu Main, Menu Setup and
Setup Asset.

In the Output Name  column, double-click  on the field name you wish to
change.  (Note that each of these fields have a 40-character maximum.)
Make your change, Enter  and ESC back to your Set Fields  Sub Menu.
You will be asked to restart BassetPro (only if you change a MENU item).
To restart BassetPro, click on the Exit  button within the File  menu. This
will end your BassetPro session.  Reload BassetPro simply by double
clicking on your program icon.
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If you want to convert your changed field name(s) back to the
default(s), from your Main Menu select Setup, Fields and Reset
All .  Again, the system will request that you restart BassetPro for
the changes to take effect.

Setup Menus
Input the information for the following fields: Supplier, Manufacturer,
Model, Short Code and Class. Note that the Setup screens are very
similar for all five fields.  Only one will be described in detail.

In the screen’s lower portion, all entries previously made are displayed.
In the middle portion of the screen, you can choose to Add , Edit  or
Delete  entries.

In the to portion of the screen the item you have selected from your list
will appear.

Add
To add a item, click on Add . Now click on Save.  Repeat this procedure
for the remaining item you wish to add to your list

Delete
When you need to delete an entry, click on the field to select it and then
click on Delete.  You will be prompted to ensure you wish to delete that
item.

ENote:
The field labels
setup under “Label
Global” overrides
anything that you
do in this setup
section.
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Edit
To Edit  an entry, select an entry from the bottom portion of your screen,
click on Edit , make your changes and then click on Save.

Setup Menu – Location
In Setup Location you can Add, Edit, and, Delete items as you could in
the previous setup screens. Unique to Setup Location is the capability of
establishing a location hierarchy.

 To select a parent for your selected location click edit and click find in the
parent description section of the screen. You will then be prompt to enter
either a barcode or description clue.
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Once you have typed the desired clue click find, the location you re-
quested will appear in the parent description field.

Setup Menu – Owner
In the Setup Owner screen you have option to setup owners with or without barcodes.
As in Setup Location you can Add, Edit or Delete information about your owners.
Information such as, department, address, telephone number can also be added in the
fields provided.

ENote:
In most cases when
you setup owner
barcodes it is
because you want to
track your assets by
who has them, not
where they are.
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Setup Menu - Bar Code
Scan  or key in your bar code number and ensure that you have selected
the correct “Type”.   Click on Continue Setup .
If the bar code is recognized by the system as already in use, this infor-
mation is displayed in the upper right corner of the screen.  Wait a few
seconds, the screen will clear and your cursor will be positioned back in
the field awaiting a new number.

Click  on the information you want the bar code to reference.
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Setup Menu - Asset
Start by scanning  or keying in the Asset Bar Code Number .  Enter all
the pertinent information for your asset on the screen. Press Tab to move
to the next field.  In fields with a drop-down box, you can move quickly to
your choice by pressing the first letter of the name that you are searching
for. For example, pressing the “h” key to find Hewlett Packard. 

If the information you require is not in one of the pop up menus on this
screen you can click the little box to the left of the field name and add it to
your list.

When you have completed your entry, choose one of the options at the
bottom of your screen; More (to enter SAP information), Save/Next,
Save/Exit or Exit.  Exit will not save your current entry or changes.
If you enter a bar code for a previously entered asset, its information will
be displayed and you can edit this information.  If you wish to discard all
of your entered information, click on the Clear  button.
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Clone an Asset
When you have a number of identical items, like 12 boardroom chairs you
only need to enter the first chair’s information a quick way to enter repeti-
tive information is to clone the information. Enter the information for the
first asset, then click Clone Product .  The background of the screen will
change to indicate that you are in the clone product mode.  In this mode,
you only have to scan in the bar code label and enter/scan in the serial
number if all else is the same.  You are able to make changes to the
other fields by clicking on them, but it is a fast and easy way to enter
repetitive information.

Setup Menu – Assets – MORE – SAP Fields
These extra screens were designed to enable you to input extra data that
is necessary for importing your data to SAP.

Setup Menu - Handheld
This setup option allows you to choose your specific handheld computer.
Click  on the handheld you are using and then on OK 
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Setup Menu - Communications
This menu option allows you to set your communications port – 1 or 2.  If
you set COMM Port 1, but your data transfer does not appear to be
working correctly, try Port 2.

 

Setup Menu - Network
This option lets you enter the path to where your database is stored

.



 Setup - Printer
Printer and printing options are set from this menu. Please note that your
Windows printer settings will override these settings.



Chapter 2

Overview:  Audit Menu

Chapter 2 explains the available features within the Action
Menu on the PC.

The following features are available within the Action Menu:

· Perform a physical Audit by a specific location
· Perform a physical Audit by a specific owner
· Associate more than one barcode to an asset
· Ability to Dispose and Un-dispose of an Asset from your

“live” database

Each of these features will be described in greater detail
throughout this chapter.
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Chapter 2
ACTION MENU

Audit by Location or Owner
The Audit function is a quick and easy way to keep track of your assets
by a particular location or owner. Both screens look and operate the same
except one tracks assets by owner and the other by location.

To start, Scan  (or key) in your Location or Owner Bar Code and press the
Enter key. Next, Scan (or key) in the Asset bar code number and press
the Enter  key.  Note:  the bottom left-hand corner of the screen with give
you a message such as “asset was moved” or “asset audited.”

If you key in an incorrect or unknown bar code number, the system will
warn you that “Bar Code xxx was not found!”.
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The date and time stamp for that asset will automatically be updated to
the current date and time. To do an audit from a new location or owner,
just scan  or key in the new Location or Owner Bar Code .

Associate
Assets tracked by BassetPro can have their existing Old Asset, Bar Code
or Serial Numbers “associated” with a new bar code number.  This is
typically used if existing data (via spreadsheet or ASCII Text import) is
used and the items to be tracked do not have bar codes attached to
them.

First, key  or scan in your bar code number in the New Bar Code  field.
Next, find the asset you want to associate with this new bar code number.
In search mode, select Type of Clue  – either Non-Bar Code or Bar Code
– and enter a search clue in Asset Clue .  Now click on the Find  box.
You can cycle through the search results by clicking on Find Next.  When
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the asset is found, click on Associate (note the upper right-hand corner –
Association was successful). You can now access that record by the new
bar code number.

Dispose/Un-Dispose
The Dispose feature allows you to take assets out of active use. Once an
asset is disposed of it will not show up in reports and will not be
downloaded to your handheld.

To dispose of an asset, go to the dispose screen, key in the barcode
number, and click to dispose button in the bottom left hand corner of the
screen. As a precaution the system will ask you if you are sure about
disposing of your asset.

The Un-dispose screen looks and works the same as the dispose screen.
Once you have un-disposed of your asset it will become active again and
show up on reports and be downloaded on to your handheld.

ENote:

You can only dispose
of Asset barcodes .

Owner, Location,
Manufacturer and
Supplier barcodes
cannot be disposed.





Chapter 3
Overview: View Menu

This chapter provides information about the options available
in the View Menu on the PC.

Although you can not make changes to the data within the
View Menu it is a very valuable tool when used to review func-
tions you have performed thus far.

Functions that can be viewed include:
· All information pertaining to a particular asset, with a search

method, in case you are unsure of the barcode
· View, preview, and print various user-customized reports
· “One line-per-item” list of all barcodes within BassetPro
· Ability to view a complete transaction history of each asset
· A complete outline of your data base that can be viewed or

printed
· All notes written on your assets, a very powerful for tracking

maintenance history
· View your complete location hierarchy right down to the

assets in your locations.
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Chapter 3

VIEW MENU

View Menu - Asset Detail
Asset Detail lets you search for a record by using the Clue function. If you
enter an asset’s number, you will go directly to the record. Or, you can
type in a clue, (ie: computer) and press Enter.  To see additional search
results, click on Find Next .  When you have completed your search, click
on Done to return back to your Main Menu.

If you wish, you can enter a freeform note up to 100 characters, by click-
ing on Write .  When your note is completed, click on Attach , then Done .
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View Menu – Asset List
Although this screen appears under the VIEW menu  option, you can also
print or export a report from this screen. You can choose to print or view
ALL your assets , or only those associated with a particular Owner,
Location or Short Description. You can also choose between a Con-
cise  (one line per asset) or a Full  (more detail) report.

View Menu – View Bar Codes
In viewing bar codes you can use the bottom and side scroll bars.  Note
that the bar codes are listed in numerical order, sorted by type: asset,
location, manufacturer, owner or supplier.

View Menu - Transactions
When opening View Transactions you will automatically see the last
record that you were working on.  Click on  “Find Item”, then either scan
or key in the bar code number you wish to see the history of.
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Item information is summarized at the top.  History transactions include
the date and time it was added to the database and when an asset was
moved or audited. It will show you when and where the item was moved
with the From and To location names.

View Menu – Transactions by Owner
Transactions by Owner is similar to Transactions, but instead of display-
ing the history of a particular asset this feature displays history of a par-
ticular owner.

When you click List Owners the owner menu will appear. From this
screen you can select an Owner and view the transaction history. You
can also print or preview your selected owner’s transactions.
This function is especially useful if you use Owner barcodes in place of
Location barcodes.
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View Menu - System Status
The System Status Report is described in the Report Menu section.

View Menu - Notes
The View Notes  feature is used to print or view notes written about your
assets. One particular asset or all your assets notes can be viewed or
printed from this screen. You can also select the number of years you
want to view the notes on your assets.

For example, if you have been writing notes on a particular printer for five
years but only want to view the notes for the past year select 1 year and
the notes for the current year will appear.
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View Menu – Location
The View Location screen is another place where the set up of your
hierarchy can be viewed. On the 1st level of the hierarchy all locations
that do not have a parent are listed.

To view assets or other locations that fall under a particular location,
double-click your desired location or asset.

The locations and assets attached will appear, you can continue these
steps until you reach the location or asset you wish to view.





SageData Solutions                                                          BassetPro                                                          39

Chapter 4
Overview:  Reports Menu
Chapter 4 will describe the various reports you can generate
through BassetPro. Each of the reports described can be
viewed, previewed, or, printed.

The following reports can be requested from BassetPro:

· A full report of all assets within your “live” BassetPro
database

· A report of all assets that are “missing” since your last
physical inventory was taken

· Assets that have been added to the system since a
specified date

· A complete list of all suppliers and manufacturers in your
database

· A complete breakdown of your database including a dollar
value of what your assets are worth

Each of these reports will be covered in more detail throughout
this chapter. There is also sample  reports included at the end
of this chapter.
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Chapter 4
REPORTS MENU

You can request reports of your Assets, Missing Assets, New Assets,
Suppliers and Manufacturers, and  the System Status, which is a sum-
mary report of your BassetPro data base.

In all Report  operations, you have the option of Printing, Viewing, or
Previewing your report.

Reports - Assets
In your opening screen, you have the option to sort by Description, Manu-
facturer, Model Number or Serial Number.  See the end of this chapter for
sample reports.

 

NOTE:

When you print,
your settings
from SETUP
Printer will be in
effect.

E
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Report Menu - Missing Assets
Note that the default in Deadline for Report  field is today’s date and
includes ALL  assets whose time stamp is later than this date.  A sample
situation — suppose you started an inventory on September 15, ending
on September 20th.  You would enter the date as September 15, as any
assets that had a date of September 14th or earlier would be labeled as
“missing” as they weren’t found during the inventory.

You can change the criteria by clicking on the Deadline for Report  field.
The date format is mm/dd/yy. 

Report Menu - Report of New Assets
You have the option of sorting your Report by Bar Code, Description,
Serial Number or Location .  The Starting Date defaults to today’s date
and includes ONLY those new assets added today.  You have the option
of keying in an alternative date in mm/dd/yy format.

If you select a date in the future, the following error message will be
displayed (upper right-hand corner of screen):
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Report Menu - Suppliers
This menu choice lets you print off a list of suppliers held in your system.

Report Menu - Manufacturers
This menu choice lets you print off a list of manufacturers held in your
system. In the following Print Preview illustration, note that double col-
umns have been used.

Report Menu - System Status
The System Status Report is the window to the status of all asset/location
information.

SELECTIONS:
Use Previous Calculation
- generates a copy of the previous calculation of information held in your
system
Recalculate this Month and Last -
recalculates the information held in your system for the current and last
month. (Does not recalculate for year to date.)
Recalculate All -
recalculates all information held in your system



44                                                               BassetPro                                                     SageData Solutions

After using BassetPro for a while, you might accumulate thousands of
pieces of equipment in your system and many transactions.  BassetPro
could take a few minutes to recalculate your system’s statistics and gives
you a message for you to confirm that you really want to do this.
The System Status Report is very useful for generating a quick “snap-
shot” of the number and value of assets you have within BassetPro. It
also shows you the number and value of assets disposed of. When you
do a back-up of your BassetPro data the date of your last back-up will
also be displayed in your System Status Report. You have the option to
Print  the report, or to Preview  it on your screen display.
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Sample Reports

System Status Report
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Sample Reports - Asset Report
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Sample Reports - Missing Asset Report





Chapter 5
Overview:  File Menu

The File Menu on the PC has a variety of functions that you
will use on a day-to-day basis when performing your asset
management. Chapter 5 will describe the various functions in
greater detail.

The following functions can be performed through the File
Menu:

· Preparing your PC for communications with your Handheld
· Exporting and importing data to and from various formats

including spreadsheets, ASCII and SAP.
· Reindex all files and data within BassetPro
· Perform back up of your BassetPro data, just in case!

Each of these functions will be explained in more detail
throughout this chapter.
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Chapter 5
FILE MENU

File Menu - Transfer
Choose this option to transfer your data between your PC and handheld
computer.

ENote:

Only the following fields
are downloaded to the
handheld: Asset Bar Code
Number, Short Descript-
ion, Serial Number,
Location, Model, Manu-
facturer, Comments, Cost,
Purchase Date, Class,
Collator and Owner.
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On your Psion handheld, load BassetPro, select Communica-
tions Mode  and press Enter .    The Workabout screen indicates
that the “Workabout is Ready”.  From your desktop, click on
Download to Handheld .  The transfer is complete when indicated
on your screen.  From this screen, you also have the option to
Upload from Handheld.  The procedure is the same.

File Menu – Transfer – Download Options
When Downloading to your Psion Workabout you can select several
options. You may be performing an inventory on assets that have a large
dollar value and don’t want to download all of your small items (this is
very handy when you have a big database.) From the Download Options
screen you can select a value limit and BassetPro will only download
assets from your database that have a specified dollar value and higher.
You may also require a particular location in your database on your Psion
Handheld. Through the Download Options you can select as many loca-
tions you want to send to your handheld. By downloading by location you
will still download all of your assets from your database but you will only
download the specified location barcodes.

Each of these options can be used on they’re own or together. For exam-
ple you may be interested in two locations in your database and in those
locations you only want to audit assets that have a dollar value of
$1000.00 or more.

ENote:
If you see retries in
the bottom left-hand
side of your PC
screen, the
connection between
your Handheld and
PC has failed. Click
ESC, check your
Comm Port setting,
and try again
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File Menu - Export Data
Here you can export all your data or a partial selection based on the
date, location or owner fields.  You can select what format you want your
data to be exported in, the file name and directory as well.

File Menu - Import Data
You choose one of three import formats: Full Import, Basset 3.x or SAP.
Use the one that is most appropriate for your situation.
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The Import File Structure  can be viewed by clicking on the “View Struc-
ture” button and printing it out for future reference. You can import exist-
ing databases by way of an ASCII text file, spreadsheet or SAP format.
Make your selection as appropriate – either ASCII or spreadsheet, and if
you want to Add (append)  the data to your database, or Refresh –
which overwrites your current database with new data – use with
caution!!! Please Note: When setting up your data’s structure the
puchase date format should be mm/dd/yyyy.

File Menu - Import Data – View Structure – Basset 3.x
The following details the file structure of the data to be im-
ported:
Col Name Type Width
A    ASSET BAR CODE Character     20
B    LOCATION Character     20
C   QUANTITY Numeric        5
D   OLD_ASSET NUMBER Character      8
E    SECTION Character     20
F     DESC1 Character     25
G    DESC2 Character     20
H    MODEL NUMBER Character     10
I     MANUFACTURER Character     20
J    SERIAL NUMBER Character     20
K    COMMENTS Character     20
L     COST Numeric       10
M    DATE PURCHASED Date              8
N     CLASS Character      2
O   ACTIVE/INACTIVE Character      1
P     COLLATOR CODE Character      4
Q    TIME STAMP Character     10
R    BUILDING Character     20
S     FLOOR Character     10
T     ROOM Character     10
U    SUPPLIER Character     30
V     OWNER Character     30
W   WARRANTY DATE Date              8
X    DEPRECIATION CODE Character      1
Y    CONTRACT NUMBER Character     20
Z     P.O. NUMBER Character     20

** Total **                    373

ENote:
If you are going from
BassetPro (version 3.x)
to BassetPro, Quantity,
Section and Active
Fields are not imported.
If you want to retain
these fields, move their
information to another
field, e.g. Building and
then rename the field
(in Setup – Fields).
Fields 18, 19, 20 are
consoli-dated into the
Location Description.
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File Menu - Import Data – View Structure – Full Import
The following details the file structure of the data to be imported:

Field  Name Type       Width Dec Index Collate
A Asset Barcode1 Character     20
B Asset Barcode2 Character     20
C Old_Asset Number Character     20
D Desc. Short Character     20
E Desc. Full Character    100
F Serial_Number Character     20
G Comments Character     30
H Cost Numeric       10    2
I Purchase Date Date               8
J Class Character     10
K Status Character       1
L Collator Code Character       4
M Depreciation Code Character       1
N Warranty Date Date               8
O Contract Number Character     20
P P.O. Number Character     20
Q Time Stamp Character     16
R Manufacturer BC1 Character     20
S Manufacturer BC2 Character     20
T Manufacturer Code Character      2
U Manufacturer Desc Character     30
V Model BC1 Character     20
W Model BC2 Character     20
X Model Code Character      2
Y Model Desc. Character     30
Z Supplier BC1 Character     20
AA Supplier BC2 Character     20
AB Supplier Code Character      2
AC Supplier Desc. Character     30
AD Location BC1 Character     20
AE Location BC2 Character     20
AF Location Code Character      2
AG Location Desc. Character     30
AH Owner BC1 Character     20
AI  Owner BC2 Character     20
AJ  Owner Code Character      2
AK Owner Desc. Character     30

** Total ** 689
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File Menu - Reindex
The Re-index feature is used as a “housekeeping” tool. It is suggested
that if you system crashes or you import a new database you should
perform the reindexing function.

To use this tool, click on the reindex button. When reindexing has been
completed the system will prompt you to press any button to continue.

File Menu - Backup
This function allows you to make a backup copy of your main data base.
This is recommended that you do on a daily basis .  In addition, you
might want to have a copy on disk off-site or in a safe storage place.
To restore your files, you have to manually copy the files from the backup
sub-directory to your BassetPro data directory and then run
Re-Index from the File menu.

ENote:
If BassetPro is being
used by multiple users,
then  ensure that users
are not accessing the
data before performing
the reindex.
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File Menu - Exit
Exit will end your BassetPro session.  You have the option to cancel this
action and return to your Main Menu screen. 

The Help Menu is currently used to give system information. You may find





Chapter 6

Overview:  Help Menu

this information helpful when you are looking for your network
ID or wondering what version of BassetPro you are using.
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Chapter 6
HELP MENU

About
System summary information is shown as indicated below. It will display
how your BassetPro program is setup. That is, where your data is stored,
which communications port you are using, your Network ID and what
version of BassetPro you are running.





Part 2

BassetPro on the Handheld





Chapter 7
Overview:  Handheld Computers

This section of the manual will cover how to maximize the
efficiency of your handheld computer when used with
BassetPro.

You will come to understand very quickly how valuable the
mobility of BassetPro is to your organization’s asset manage-
ment.

In this chapter we will discuss:

· The Psion Workabout handheld computer
· Main and back-up batteries
· Troubleshooting the Workabout
· Initial setup for BassetPro
· Main Menu of BassetPro
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Chapter 7
HARDWARE SETUP

The PSION Workabout handheld computer will be illustrated in this por-
tion of the manual.

Workabout Computer
The Workabout is a robust handheld computer, ideal for mobile use
outside of an office.  It is dust proof and splash proof.  Should you ever
need to clean it, first turn it off and then gently wipe the keyboard and
screen with a soft, clean, dry cloth.

Batteries
By pushing the Disk/Battery Drawer Release Button (upper left hand
corner), the top part of the Workabout will “pop” out and you can slide in
your program and data disks.  Two AA alkaline batteries can be inserted
in the battery component.
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You can use ordinary rechargeable batteries or a special PSION battery
pack.

If you use standard Ni-Cad rechargeable batteries and not the
PSION Workabout rechargeable battery packs, you cannot
recharge them while they are in the Workabout computer.

When changing the main batteries, the Workabout is powered by
the lithium backup battery.  If you remove both the lithium and
AA batteries at the same time, you will lose all the data stored in
the main internal memory of the Workabout.

Information stored on your SSDs (solid state disk) do not need battery
power to keep their contents safely stored, and have a shelf life of many
years.

Low Battery Warning
When the main batteries become low, a “Main battery is low” message
is displayed on the bottom right-hand corner of the Workabout screen.
With a low battery, the Workabout may have enough power to display
information on the screen, or accept data that you have typed on the
keyboard; however, it may not  have enough power to save information
or to scan in a bar code.

If you try to do something for which the Workabout does not have
enough power, it will automatically switch off.  No information will be
lost, as the backup battery will maintain the information in the internal
memory for several days.  It is recommended that you change batteries
as soon as possible after receiving a low battery warning.
NOTE:It is possible to damage the solid state data disk (SSD) and
corrupt your data files  if you attempt to save the information and the
batteries are too low to write to flash.  If you get this message, then turn
the Workabout off and put in fresh batteries before attempting to go any
further.

Automatic Switch Off
The Workabout switches off automatically when it has been idle for a
certain amount of time - normally five minute.

ENote:

On the MX
Workabout the
D i s k / B a t t e r y
Drawer Release
Button is on the
back of the
handheld (upper
left hand corner).
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When the Workabout is turned off, no information is lost.  When turned on
again, you continue exactly where you left off, even if you were in the
middle of an entry.

Troubleshooting
If your Workabout seems to be malfunctioning, read the relevant sections
below and carry out the recommended checks and corrective actions.  If
they don’t solve your problem, contact your supplier.

The Workabout Won’t Turn On
When you first switch on the Workabout, there may be a delay of a few
seconds before any information is displayed.  If the screen continues to
remain blank, try pressing the Contrast key.
If this doesn’t work, you will need to check that the Workabout is receiving
power - make sure that the charged  batteries are fitted correctly.

Workabout Turns Off  When You Scan An Asset
This is usually an indication that the batteries are running low.  Check
your batteries and insert new ones if needed.  This will typically happen
with laser scanners when the batteries are running low.

Scanner Won’t Scan
In the event the scanner will not read a bar code, check the Workabout to
ensure you are in a BassetPro program module that is asking you to scan
in a bar code.

Workabout “locks up”
If an application “crashes” (i.e. you get no response when you key infor-
mation on your keyboard), you will need to reset the Workabout.  Do this
only when you have tried the previous troubleshooting suggestions.  To
reset the Workabout press the PSION+CTRL+DEL  keys all at the same
time. When you turn the Workabout on again, it will beep, briefly display
the PSION logo screen and automatically start the BassetPro Program.
If you were in the middle of an entry or transaction, it is possible that you
may have lost that entry.  Just go back and scan the location and asset
bar code to ensure that the last changes had been saved.

Data Transfer Isn’t Working
If you’ve tried to transfer data and the system is not responding properly,
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check to make sure that the cable connecting the Workabout to the PC is
attached to the RS-232 interface.

If this is not the problem, ensure that the cables are securely connected
to their respective interfaces.  On the PC, you can change the communi-
cations port under the “Setup - Communications” menu and see if this
resolves your problem.

There can be an additional problem if your PC has an internal fax/mo-
dem.  You may have to temporarily unplug your mouse and connect the
communications cable to that interface on your PC.

RUNNING BassetPro ON THE WORKABOUT

Initial Set-up - Workabout
Insert the program disk in the bottom (B) slot of the Workabout and the
data disk in the top slot (A).  Press the following three keys simultane-
ously PSION + CTRL+ DEL.  The Psion logo will fill the screen first, next
the BassetPro intro screen and then your Main Menu.

Main Menu - Handheld

Your Main Menu options are File, Action, Setup and Help.  The bottom
left of the screen indicates the program name and version and the date
setting of the Workabout.

The bottom right of the screen indicates the room available on your SSD
in 1,000s of characters (1941K means that you have 1,941,000 charac-
ters available on your data disk in the handheld).
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Important

To protect the integrity of your data,
Always make sure that the date and

time is correctly set!





Chapter 8

Overview:  Handheld -  File menu

The File Menu on the Workabout is a menu you will probably
use quite frequently since it is where the communications
mode is.

Whenever you need to communicate with your PC you will
need to be in communication mode on your Handheld.

This chapter will describe the steps to take to ensure that
every use of the communications mode on the Handheld is a
successful one.





SageData Solutions                                                          BassetPro                                                          75

Chapter 8
FILE MENU - Handheld

In your File Menu, Communication Mode is highlighted.   Press Enter  and
the screen will display the following message: “Communication Mode
Workabout is Ready.”  The Workabout is now ready to communicate with
the desktop version of BassetPro.





Chapter 9
Overview:  Handheld - Action Menu

This chapter will cover the menu that is most used within
BassetPro on the Handheld - the Action Menu.

 The following tools can be used within the Action Menu:

· Perform a physical Audit, or if you want to perform a quick
check on your assets – Quick Audit
· Write and view Notes on your assets
· Verify your data’s information, including location using the
View function

All of these features will be covered in greater detail through-
out this chapter
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Chapter 9
ACTION - Handheld

Action Menu - Audit
Audit and Quick Audit function basically in the same manner.  Audit has
the capability to Association, Edit and Add in new assets, locations,
models, manufacturers, and owners.

If the bar code number is not found, you will have the option to Add  it or
Associate  it with an existing record.  When you choose Add , you then
tell BassetPro if it is an Asset  or Location bar code.  When you add in a
new asset you must press the Menu  key and enter the Model, Manufac-
turer and Owner fields, to get a selection of previously entered items to
choose from.

By entering the first letter of your Model, Manufacturer or Owner you will
immediately go to the beginning of letter’s section in the handheld.  If you
were looking for Hewlett Packard you would press the letter “H”, then “E”.
At any time, you can use the up and down arrow keys to highlight your
choice.  You then press Enter  to accept that choice.
If there is a Model, Manufacturer or Owner you need but it is not in your
pre-set menus, you can add it by first pressing the Menu  key then start
keying in the information. A screen will pop-up saying item not found,
press Enter  to add, continue adding the information, then Enter  again to
save.

Pressing Enter  takes you from field to field and ESC gives you the option
to Save the information or to forget it.
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If you choose the Associate  feature, you can Associate a new bar code
number with a previous bar code, serial number or old asset number.
Press Tab to see your options and choose accordingly.

Action Menu - Quick Audit
This feature is used to speed up the inventory process.  Not all Audit
features are available to the user.  For example, you will not have the
ability to Edit the asset information, or to Associate it with another tracking
number (e.g. serial number).

Scan or key in the Location bar code.  If you are using the keypad, key in
the number and press Enter.  If the bar code number is invalid, a mes-
sage to that effect will appear on the screen.  ESC and re-enter the
number.

The description of the Location bar code will be indicated at the top of
your screen and you will be asked for an asset bar code.  Key or scan in
the number.  If the asset number you scanned is not registered to the
Location bar code, a warning will be given.  You now have the option to
Ignore, or Move.

The situation where Ignore would be used — you are in the President’s
office and have completed your audit.  You move to the Warehouse and
start to audit.  If you do not change the Location bar code to the Ware-
house, you will be given the option to Move or Ignore.  When you choose
Ignore, you can ESC back to enter in the Warehouse Location bar code
and then continue with your audit.

To move the asset, press M for Move. This will automatically create a
transaction record (see View Menu – Transactions  for an example).
When you have completed your audit, press ESC to go back to the Main
Menu.
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Action Menu – Audit by Owner
If you have assigned barcodes to owners within your database this func-
tion will allow you to perform an inventory by a particular owner. The
screen works and looks the same as Audit, the only difference is Audit
uses location barcodes and Audit by Owner uses owner barcodes.

Action Menu - Notes
Notes allows you to type in a 100 character message and attach it to an
asset.  You can enter and view notes exactly as you would in the desktop
version.

Action Menu – Missing Assets
The missing assets function on the Psion handheld is a quick and easy
way to check a location you have just audited for asset you may have
missed.

By scanning the location you wish to check for missing items the system
will provide you with a list of items that were in that location the during the
previous audit but were not scanned this time. For example, if you are
auditing an office that had a printer in it the last time you performed an
inventory and it was not scanned this time the Missing Assets function will
tell you a printer is missing.

Action Menu - View
This options allows you to scan an asset and see all the informa-
tion that you would see in the Audit or Audit by Owner screen,
PLUS, the last location the item was inventoried in and the last
date and time the asset was scanned.

ENote:

No changes can be
made in this screen
as it is a view screen
only.





Chapter 10

Overview:  Handheld - Set-up Menu

The Setup Menu on the Handheld is used specifically to setup
short codes for your short descriptions of your assets.

Setting up your short codes in advance will prove to be a time
saving step when your perform your physical inventory for the
first time.

This chapter will describe the step to take to make your
BassetPro system more efficient.
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Chapter 10
Setup Menu

Short Code
Short codes are valuable in reducing the amount of keystrokes you need
to used when entering data for your assets.

Enter a clue, or the short code, for the description you are looking for and
press Enter  to search.

If the short code is already in the system it will appear, if not you can input
the description you want assigned to that short code. Press Enter to save
or Esc to cancel.

ENote:

If there is a short code
you want to delete,
perform the same
steps as outlined
above and press Tab
to delete to short code.





Chapter 11

Overview:  Handheld- Help Menu

The Help Menu on the handheld is used for a variety of func-
tions; each will each be described in this chapter.

The Help Menu offers the following tools:

· Setting the proper data and time
· Formatting your data disk
· Choosing the type of scanner your organization uses with

BassetPro

We think you will each of these items valuable housekeeping
tools to use with BassetPro.
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Help Menu

HELP - Handheld

Help Menu - Set Date/Time
Firstly, ensure that the Workabout’s time and date setting is correct.  You
will see this at the bottom of your Main Menu.

If you want to make changes, cursor down to Set Date/Time  and press
the Enter  key.

Press Y for Yes or N for No.

Your cursor will be blinking at the Hour Field.  When you have entered the
hour, press the Enter key.  Continue down your options, pressing the
Enter key to confirm your data.
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When you have confirmed the Year field, BassetPro will indicate your
choice with Press any key….(to continue).  You will be returned to the
Help Menu.

Help Menu - Scanner
You must select the scanner being used, either T for Tethered (separate
scanner attached to Workabout with a cable) or I for Integrated (Laser
scanner only).  One exception is for the Workabout WAND, choose T for
Tethered.

Using your cursor keys, move to Scanner , and press the Enter  Key.
Press T for Tethered, or I for Integrated.
You will be returned to the Main Menu.

Help Menu - Format Data Disk
Your data disk stores all the data collected by the handheld through the
Audit and Notes functions.  When you have completed an audit with the
handheld, you would upload this information to the main database being
held on the desktop version of BassetPro.  Depending on the number of
assets you are working with, you may want to format the data disk follow-
ing each audit.

You can check the bottom of the screen of the main menu to check how
much free disk space you have on your data disk. If this is under 10K,
then you will want to transfer all your data to your PC first, then format
your disk.

ALL DATA IS ERASED from your handheld after formatting the disk!
By pressing Y for Yes, the formatting will be initiated.  To cancel out this
action, either press N for No, or ESC to return to the main menu.
The Main Menu of BassetPro shows you how many thousands of charac-



ters are available on your data disk.  If you notice that your BassetPro
system is slowing down during an audit and you haven’t formatted your
disk in 1 – 2 months, it’s advisable to transfer all your information to your
PC, format the disk and then transfer the data back to the handheld.





APPENDIX A

Frequently Asked Questions

Many of our users experience difficulties with communications.
This appendix was added to help those users  troubleshoot
what the cause is of their communications problems, and, to
hopefully answer any questions you may have.
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Frequently Asked Questions

Communications / File Transfers not working:
Typically occurs when:

a).  Wrong comms port selected – try Comm 1 then Comm 2
b).  Comms port is faulty – try another PC  built by another manufac-
turer**  this is very very common, even one-way data comms is
possible
c).  Serial cable used and not a NULL MODEM cable
d).  Cable plugged into Bar Code Interface and not the RS-232
e).  Older version of our software that does not run on new OVAL units
f).  Internal Fax Modem and a Serial Mouse already on your PC – must
disable mouse to enable communications.  Better still, is to use a PC that
doesn’t have an internal modem.
g). Always have Workabout start communications FIRST!
h).  Try re-booting Workabout – press PSION (È) + CTRL+DEL keys
together. (PSION Key is bottom left-hand key)
i).  Ensure that LINK is OFF from Workabout’s System Screen .

Configurations:
Must have a separate data disk – we do not use internal memory due to
support issues.  A program disk comes with package.

Communications is the main problem that people have with our programs.
Any other questions about the use of the program, can be easily an-
swered by referencing the user manual index pages or by sending an e-
mail to nt@sage.ca.





APPENDIX B

Evaluation Database

BassetPro is delivered to our clients with a blank database.

If you are using this copy for evaluation purposes, please read
the following appendix for instruction on how to import a sam-
ple database.
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Appendix B
INSTRUCTIONS FOR IMPORTING EVALUATION DATABASE

If you are using BassetPro for evaluation purposes, we have included a
sample database for your convenience. To install this database, go to
File  and select Import – Full Import.

The screen shown above will then appear. At this point you will select
ASCII as the format and Refresh as the update type. After clicking on
Import , a warning screen will appear, click Continue. Once the Import is
complete a message will appear in the top right hand corner of the
screen. Press any key or click the mouse to continue. Click on Done.
Congratulations, you should now have a sample database.





Appendix C
New Features

We, at SageData, are continuously striving to develop an
asset management package with the end user in mind.

We take the input from our present and future clients and try to
accommodate each organizations needs.

This appendix will cover all the recent changes to BassetPro
on both the PC and the Handheld.
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Appendix C
New Features for BassetPro Version 3.3H

On the Handheld
Missing Assets  – This function allows you check a particular location in
your database for any assets you may have missed while performing an
inventory. See page 88 for further information about this function.

On the PC
Setup Owner  – Setup Owner and Setup Owner Detail screens have
been combined to simplify adding, editing and deleting owner information.
List button added to make searching for an owner easier. See page 22 for
more information.

Setup Location – Setup Location and Setup Location Detail screens
have been combined to simplify adding, editing and deleting location
information. List button added to make searching for a location easier.
See page 21 for more information.

Setup Asset  – Ability to add information to the six pop up menus on this
screen. See page 24 for more details.

Trasaction by Owner – View and print transaction for a particular owner
in your database. You are also give the option to select how many years
back you want to view. See page 41 for more information.

Full Report  – Information entered in the comments field of an asset now
appears on reports if the information type “full” under View Asset List
Screen is selected. See page 38 for more information.

Download Options  – You can now choose to a particular dollar value or
only certain locations when downloading from your PC to your Psion
Workabout. See page 58 for more details.
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